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SAFETY PRECAUTIONS
Always read the precautions before using this product.
Also read this manual and the relevant manuals mentioned in this manual carefully, and use the product properly while paying 
full attention to safety.
Note that the precautions in this manual apply only to this product.
The safety precautions are divided into the following levels: WARNING and CAUTION.

Note that failure to observe CAUTION may lead to a serious accident depending on the circumstances.
Make sure to observe both warnings and cautions to ensure personal safety.
Ensure that this manual is easily accessible to all users of this product.

[Test Operation Precautions]

WARNING
● Before testing the operation of a user-created screen (such as turning on or off a bit device, changing 

the current value of a word device, changing the set value or current value of a timer or counter, and 
changing the current value of a buffer memory), thoroughly read the manual to fully understand the 
operating procedure.
During the test operation, never change the data of the devices which are used to perform significant 
operation for the system.
Doing so may cause an accident due to an incorrect output or malfunction.

WARNING

CAUTION

Indicates that incorrect handling may cause hazardous conditions, 
resulting in death or severe injury.

Indicates that incorrect handling may cause hazardous conditions, 
resulting in minor or moderate injury or property damage.
1
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CONSIDERARIONS FOR USING THIS SOFTWARE

Memory capacity of your personal computer
Windows may terminate running processes on a personal computer with less than 512 MB of memory.
Use MELSOFT GT OPC UA Client on a personal computer with at least 512 MB of memory.

Required amount of virtual memory on the hard disk
MELSOFT GT OPC UA Client requires at least 100 MB of virtual memory on the hard disk while it is running.
If the amount of virtual memory is less than 100 MB while MELSOFT GT OPC UA Client is running, Windows may terminate 
running processes.
Make sure that there is enough virtual memory on the hard disk to use MELSOFT GT OPC UA Client.
When there is little virtual memory on the hard disk, save your project frequently.

Error massage displayed when this software is started or while it is running
MELSOFT GT OPC UA Client checks the amount of available memory space when:
 • MELSOFT GT OPC UA Client is started.
 • Obtaining tag information.
 • Saving tag information.
When the amount of virtual memory is less than 100 MB, the following message appears.
[Operation will be terminated because of insufficient memory. Would you like to stop?] 
To stop the operation, click [Yes]. (MELSOFT GT OPC UA Client will not close.)
To continue the operation, click [No].
In this case, exit some running applications or restart Windows to free up memory.

Screen settings in Windows
Do not change the Windows font size from the default. Otherwise, dialogs or other on-screen items may appear improperly.
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RELEVANT MANUALS
The following shows the manuals relevant to this product.
If you need the printed manuals, consult your local sales office.

Manuals
■Screen design software-related manuals

■GT SoftGOT2000 manuals

e-Manual refers to the Mitsubishi Electric FA electronic book manuals that can be browsed using a dedicated 
tool.
e-Manual has the following features:
 • Required information can be cross-searched in multiple manuals.
 • Other manuals can be accessed from the links in the manual.
 • Hardware specifications of each part can be found from the product figures.
 • Pages that users often browse can be bookmarked.
 • Sample programs can be copied to the engineering tool.

Manual name Manual number
(Model code)

Format

GT Designer3 (GOT2000) Screen Design Manual SH-081220ENG
(1D7ML9)

PDF
e-Manual

Manual name Manual number Format
GT SoftGOT2000 Version1 Operating Manual SH-081201ENG PDF

e-Manual
5
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ABBREVIATIONS AND GENERIC TERMS
The following shows the abbreviations and generic terms used in this manual.

Software
■Software related to GOT

Terminology
The following shows the terms in this manual unless otherwise specified.

Abbreviations and generic terms Description
GT Designer3 Screen design software for GOT2000 series included in GT Works3

GT OPC UA Client MELSOFT GT OPC UA Client (SW1DNN-GTOUC-MD)

GT SoftGOT2000 GOT2000 compatible HMI software GT SoftGOT2000

Term Description
OPC Abbreviation of OLE for Process Control.

An interoperability standard for the secure and reliable exchange of data in the 
industrial automation space and in other industries.

OPC UA Abbreviation of OPC Unified Architecture.
A platform independent service-oriented architecture that integrates all the 
functionality of the individual OPC Classic specifications into one extensible 
framework.

OPC UA tag A tag that is used to access the device data of a controller from an OPC UA 
client.

Tag information Information that includes the names, configuration, and data types of OPC UA 
tags.

Endpoint A server or client that is connected at the end of a network.
It can be a personal computer or OPC UA server.

Server certificate A digital certificate for authenticating a server with SSL authentication.
It is used for encrypting data transmitted between GT OPC UA Client and an 
OPC UA server, and for mutual authentication between them.

Client certificate A digital certificate for authenticating a client with SSL authentication.
It is used for encrypting data transmitted between GT OPC UA Client and an 
OPC UA server, and for mutual authentication between them.
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1 INTRODUCTION
Thank you for downloading MELSOFT GT OPC UA Client.
This manual explains the overview, specifications, installation and uninstallation procedures, and basic usage of MELSOFT 
GT OPC UA Client (hereafter called "GT OPC UA Client").
Before using the product, read this manual carefully and make sure you understand the functions and performance of GT 
OPC UA Client for correct use.

To obtain the latest version of GT OPC UA Client, contact your local sales office.

1.1 Features
The following shows the features of GT OPC UA Client.

Settings for connecting to an OPC UA server
In GT OPC UA Client, you can configure settings to connect the personal computer and an OPC UA server.
You can search for an OPC UA server and obtain the endpoint URL of the server if the following conditions are satisfied.
 • A personal computer on which GT OPC UA Client is installed and an OPC UA server are on the same subnet.
 • GT OPC UA Client and an OPC UA server are installed on the same personal computer.

Personal computer

GT OPC UA Client

OPC UA server

Ethernet (same subnet)

Search for the OPC UA server

Acquire the end point URL 
of the OPC UA server
1  INTRODUCTION
1.1  Features 7
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Collectively reading tag information
GT OPC UA Client collectively obtains tag information from an OPC UA server and exports the information to a tag 
information file.
By importing the tag information file to GT Designer3, you can specify OPC UA tags as devices monitored by GT 
SoftGOT2000.

OPC UA library
GT OPC UA Client has an OPC UA library to connect GT SoftGOT2000 and OPC UA servers.
To connect GT SoftGOT2000 to an OPC UA server, install GT OPC UA Client on the personal computer on which GT 
SoftGOT2000 resides.
Once GT SoftGOT2000 connects to an OPC UA server, GT SoftGOT2000 can read data collected by the server or write data 
through the server.

Personal computer

GT Designer3GT OPC UA Client

OPC UA server

Acquire 
the tag 

information

Acquire the tag 
information

Export Import

Address Space

Dev00

Group000

Str000

Dev01

OPC UA tag
• Tag000

• Tag001

• Tag002

Tag information

Device setting

Personal computer

GT SoftGOT2000

OPC UA serverControllers compatible with OPC UA

Read device values 
to the OPC UA tag

Write the OPC UA tag 
values to the device

GT OPC UA Client

OPC UA 
library Refer to for connecting 

with OPC UA server

Read values from the OPC UA tag

Write values to the OPC UA tag

• Tag000
• Tag001
• Tag002

OPC UA tag
• R0D00
• R0D01
• R0D02

Device
1  INTRODUCTION
1.1  Features
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2 SPECIFICATIONS
The following shows the specifications of GT OPC UA Client.

2.1 Operating Environment
The following shows the operating environment for GT OPC UA Client.

*1 For installation, administrator privileges are required.
For startup, the standard user or administrator account is required.
To use GT OPC UA Client with another application that runs with administrator privileges, run GT OPC UA Client with administrator 
privileges.

*2 The following functions are not supported.
Application start in Windows compatibility mode
Fast user switching
Change your desktop themes (fonts)
Remote desktop
Setting the size of text and illustrations on the screen to any size other than [Small-100%]

*3 Operation is not supported in an environment with the text cursor indicator turned on.
*4 A virtual environment such as Hyper-V is not supported.
*5 Tablet mode is not supported.
*6 Unified Write Filter is not supported.
*7 Change [Current Default] for [.pdf] from [Reader] to [Adobe Reader] using the Windows Control Panel.

Item Description
Model Windows-compatible personal computer

OS (English version)*1*2*3*4*5*6 • Microsoft Windows 11 Education (64 bit)
• Microsoft Windows 11 Enterprise (64 bit)
• Microsoft Windows 11 Pro (64 bit)
• Microsoft Windows 11 Home (64 bit)
• Microsoft Windows 10 Enterprise (32 bit, 64 bit)
• Microsoft Windows 10 Pro (32 bit, 64 bit)
• Microsoft Windows 10 Home (32 bit, 64 bit)
• Microsoft Windows 10 IoT Enterprise 2016 LTSB (64 bit) (English OPK, or English OPK and a language pack for 

localization)

CPU • Windows 11: 64 bit-compatible processor with dual-core or more or System on a Chip (SoC)
• Windows 10: Intel Core 2 Duo Processor 2.0 GHz or more recommended

Memory • For Windows 11: 4 GB or more recommended
• For 64-bit Windows 10: 2 GB or more recommended
• For 32-bit Windows 10: 1 GB or more recommended

Display Resolution: XGA (1024 × 768 dots) or higher

Hard disk space • For installation: 5 GB or more recommended
• For execution: 512 MB or more recommended

Display color High Color (16 bits) or higher

Other software applications To display PDF manuals, the following software application must be installed.
• Adobe Reader7 or later recommended *7

Other hardware devices Use the hardware compatible with the above OS.
• For installation: Mouse, keyboard, and DVD drive
• For execution: Mouse and keyboard
2  SPECIFICATIONS
2.1  Operating Environment 9
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2.2 System Architecture
The following shows the architecture of the system when GT OPC UA Client is used.

OPC UA server

• Tag000
• Tag001

OPC UA tag

• Tag000
• Tag001

OPC UA tag

Personal computer

Tag information 
file

Import

GT Designer3

Ethernet

OPC UA server Personal computer

Controllers compatible with OPC UA

Ethernet

Personal computer

GT SoftGOT2000 
(client)

GT OPC UA Client

OPC UA 
library Refer to for connecting 

with OPC UA server

Personal computer

GT Designer3

GT OPC UA Client 
(client)

Tag information 
file

Export

Import

Acquire the tag 
information

GT OPC UA Client 
(client)

Tag information 
file

Export

Copy

Acquire the tag 
information

Read/write values 
from/to the OPC UA tag

Read/write values 
from/to the OPC UA tag

Personal computer

GT SoftGOT2000 
(client)

GT OPC UA Client

OPC UA 
library

Read/write values 
from/to the OPC UA tag

Refer to for connecting 
with OPC UA server

Read/write values 
from/to the OPC UA tag
2  SPECIFICATIONS
2.2  System Architecture
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2.3 Required Software
The following shows the software required to use GT OPC UA Client.

2.4 OPC UA Servers
The number of connectable clients depends on the specifications of OPC UA servers.
A client can be GT OPC UA Client or GT SoftGOT2000.
The following shows the specifications of OPC UA servers accessible by GT OPC UA Client.

Specifications

Recommended servers
For recommended OPC UA servers, refer to the following Technical Bulletin.
List of OPC UA Servers Validated to Operate with the GOT2000 Series (GOT-A-0137)
For the Technical Bulletin, refer to the MITSUBISHI ELECTRIC FA Global Website.
www.MitsubishiElectric.com/fa

2.5 Tag Information
The structure of tag information depends on the OPC UA server to be used.
For the details of tag information, refer to the following.
OPC UA server manual
For tag information files that can be imported to GT Designer3 and the details of OPC UA tags, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

Software Version
GT Designer3 Version 1.215Z or later

GT SoftGOT2000

Item Specifications
Version OPC UA 1.03 or later

Required service set The following OPC UA service sets are required.
• Discovery Service Set
• SecureChannel Service Set
• Session Service Set
• View Service Set
• Attribute Service Set
2  SPECIFICATIONS
2.3  Required Software 11
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3 INSTALLATION AND UNINSTALLATION
The following explains the installation and uninstallation of GT OPC UA Client.

3.1 Installation

Precautions before installation
■User login privileges
Log in to your personal computer with the administrator account.
If you log in with an account other than the administrator account, you cannot install GT OPC UA Client.

■Exiting running software applications
Before installing GT OPC UA Client, exit all running software applications.
If you install GT OPC UA Client while other software applications are running, GT OPC UA Client may not run properly.

■Turning off automatic updating in Windows
Turn off automatic updating in Windows, and then install GT OPC UA Client.
If Windows checks for updates during installation of GT OPC UA Client, the software installer may not operate properly.

■Disabling the compatibility mode
Disable the compatibility mode in Windows.
Otherwise, the installation of GT OPC UA Client will fail.

■Unusable characters and strings
The following characters and strings cannot be used to specify the installation destination folder.
 • / * < > | : ;
 • Windows reserved words (COM0 to COM9, LPT0 to LPT9, AUX, CON, PRN, NUL, and CLOCK$)

■Folder that cannot be specified as the installation destination
The [Documents] folder cannot be specified as the install destination.

■Running Windows Update
Run Windows Update in advance to update your personal computer.
Otherwise, the installation may fail.

Procedure
The following shows how to install GT OPC UA Client.

1. Unzip the file downloaded from the MITSUBISHI ELECTRIC FA Global Website, and run setup.exe.

2. In the setup wizard, follow the on-screen instructions to install the software.

3. When the installation is complete, click the [Finish] button to exit the installer.
If Windows needs to be restarted, click the [Finish] button, and then restart Windows.
3  INSTALLATION AND UNINSTALLATION
3.1  Installation
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3.2 Uninstallation

Precautions before uninstallation
■Exiting GT OPC UA Client
While GT SoftGOT2000 or GT OPC UA Client is running, you cannot uninstall GT OPC UA Client.
Exit GT OPC UA Client before uninstallation.

Procedure
The following shows how to uninstall GT OPC UA Client.

1. Open [Control Panel], select [Programs and Features], select and right-click [GT OPC UA Client Setting Tool], and select 
[Uninstall].

2. Follow the on-screen instructions to uninstall the software.

3. Click the [Finish] button to complete the uninstallation.
3  INSTALLATION AND UNINSTALLATION
3.2  Uninstallation 13
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4 OPERATING PROCEDURE
The following outlines how to obtain tag information from an OPC UA server and export the information to a tag information 
file.

1. Start GT OPC UA Client.
Page 15 Starting GT OPC UA Client

2. Connect GT OPC UA Client to an OPC UA server.
Page 16 Connecting GT OPC UA Client to an OPC UA Server

3. Establish a trust relation between GT OPC UA Client and the OPC UA server using their certificates as necessary.
Page 21 Verifying a server certificate in GT OPC UA Client

Page 21 Verifying a client certificate on an OPC UA server

4. Obtain tag information from the OPC UA server.
Page 24 Obtaining tag information

5. Export the information to a tag information file.
Page 25 Exporting tag information
4  OPERATING PROCEDURE
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6. Import the exported tag information file to GT Designer3.
For details on how to import the file, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual
To start GT OPC UA Client from GT Designer3 and obtain tag information from an OPC UA server, refer to the following.
Page 26 STARTING GT OPC UA Client FROM GT Designer3

4.1 Starting and Exiting GT OPC UA Client
The following shows how to start and exit GT OPC UA Client.

Starting GT OPC UA Client
To start GT OPC UA Client, select [Start] → [MELSOFT] → [GT OPC UA Client Setting Tool].
To change the display language, refer to the following.
Page 30 CHANGING THE DISPLAY LANGUAGE

Exiting GT OPC UA Client
To exit GT OPC UA Client, perform one of the following operations.
 • Select [Project] → [Exit] in the main window.
 • Click the [×] button on the title bar.
4  OPERATING PROCEDURE
4.1  Starting and Exiting GT OPC UA Client 15
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4.2 Connecting GT OPC UA Client to an OPC UA 
Server

The following explains connecting GT OPC UA Client to an OPC UA server.

Connecting GT OPC UA Client to an OPC UA server
The following shows how to connect GT OPC UA Client to an OPC UA server.

1. In the main window, select [Project] → [Access destination device setting] from the menu to display the [Access 
destination device setting] dialog.

Page 17 [Access destination device setting] dialog

2. Set the following items.
 • [End point URL]
 • [Security Policy]
 • [Security Mode]
 • [Timeout Time]

3. Click the [Check] button to send a connection request from GT OPC UA Client to the OPC UA server.
If the settings are configured correctly, and a trusted server certificate and client certificate exist, the server name obtained 
from the OPC UA server appears in [Server Name].
To verify the server certificate or create a client certificate, refer to the following.
Page 21 Verifying a server certificate in GT OPC UA Client
Page 21 Verifying a client certificate on an OPC UA server

4. Set [User token type].

5. Click the [OK] button to establish connection between GT OPC UA Client and the OPC UA server.

3. 

2.

4.

5.
4  OPERATING PROCEDURE
4.2  Connecting GT OPC UA Client to an OPC UA Server
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[Access destination device setting] dialog
The following shows the setting items in the [Access destination device setting] dialog.

You can save the access destination device settings to a setting file (*.gtpm).
The file (*.gtpm) is readable with GT OPC UA Client on other computers.
For information on how to save the settings to a setting file (*.gtpm) and read the file, refer to the following.
Page 19 Saving access destination device settings to a file
Page 19 Reading access destination device settings from a setting file

No. Item Description
1) [End point URL] Set the endpoint URL of the OPC UA server.

Up to 1024 characters can be entered directly.
Click the [Search] button to search for OPC UA servers on the host or subnet on which GT 
OPC UA Client resides. *1

Page 18 [Search] dialog

2) [Server Name] Displays the OPC UA server name.

3) [Security Policy] Select a security policy for communication.
Set this item according to the setting of the OPC UA server to be connected.
• [None]

Does not encrypt messages.
• [Basic128Rsa15]

Uses 128-bit encryption.
• [Basic256]

Uses 256-bit encryption.
• [Basic256Sha256]

Uses digital signing and 256-bit encryption.

4) [Security Mode] Set whether to digitally sign or encrypt messages.
Set this item according to the setting of the OPC UA server to be connected.
• [None]

Does not encrypt messages.
• [Sign]

Digitally signs messages.
• [SignAndEncrypt]

Digitally signs and encrypts messages.

5) [Timeout Time] Set a time-out period to connect to the server.
The setting range is [1] second to [30] seconds.

6) [Check] button Checks the settings in [Setting of connection end server] and the presence or absence of a 
trusted server certificate and client certificate.
• If the settings are configured correctly, and a trusted server certificate and client certificate 

exist, the server name obtained from the OPC UA server appears in [Server Name].
• If no trusted server certificate exists, the [Authentication of server certificate] dialog appears.
Page 19 [Authentication of server certificate] dialog
After verifying the server certificate, click the [Check] button again to display the server name 
obtained from the OPC UA server in [Server Name].
• If no client certificate exists, the [Creation of client certificate] dialog appears.
Page 22 [Creation of client certificate] dialog
After creating a client certificate, click the [Check] button again to display the server name 
obtained from the OPC UA server appears in [Server Name].

1)

2)
3)
4)
5) 6)

7)

9)
8)
4  OPERATING PROCEDURE
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*1 Some OPC UA servers cannot be searched for in the [Search] dialog depending on their types.

■[Search] dialog

7) [User token type] Select a user authentication method.
• [Anonymous user]

Performs an anonymous login.
• [User name/Password]

Authenticates users with a user name and password.
Select this item, and set [User Name] and [Password].

8) [OK] button Connects GT OPC UA Client to the OPC UA server, and closes the [Access destination device 
setting] dialog.

9) [Cancel] button Cancels the settings, and closes the [Access destination device setting] dialog.

No. Item Description
1) [Host] Enter all or part of a host name and click the [Search] button to display the search results in 

the endpoint URL list.

2) Endpoint URL list Lists the endpoint URLs of the OPC UA servers found.
Select the endpoint URL of the OPC UA server to be connected.

3) [OK] button Reflects the selected endpoint URL to the [Access destination device setting] dialog, and 
closes the [Search] dialog.

4) [Cancel] button Closes the [Search] dialog.

No. Item Description

2)

1)

4)
3)
4  OPERATING PROCEDURE
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■[Authentication of server certificate] dialog

Saving access destination device settings to a file
You can save access destination device settings to a setting file (*.gtpm).
The file (*.gtpm) is readable with GT OPC UA Client on other computers.
The following shows how to save the access destination device settings to a setting file (*.gtpm).

1. In the main window, select [Project] → [Save as Access destination device setting] from the menu to display the [Save as 
Access destination device setting] dialog.

2. Specify where to save a setting file, a file type and a file name, and click the [Save] button to save the settings to the 
setting file (*.gtpm).

Reading access destination device settings from a setting file
You can read access destination device settings from a setting file (*.gtpm).
The following shows how to read access destination device settings from a setting file (*.gtpm).

1. In the main window, select [Project] → [Open Access destination device setting] from the menu to display the [Open 
Access destination device setting] dialog.

2. Specify the location of a setting file, file type and file name, and click the [Open] button to open the file.

3. Connect GT OPC UA Client to an OPC UA server in the [Access destination device setting] dialog.
Page 17 [Access destination device setting] dialog

No. Item Description
1) [Field] Displays the fields in the server certificate.

2) [Value] Displays the values obtained from the server certificate.

3) [OK] button Installs the server certificate as trusted, and closes the [Authentication of server certificate] 
dialog.

4) [Cancel] button Does not install the server certificate, and closes the [Authentication of server certificate] 
dialog.

2)

4)
3)

1)
4  OPERATING PROCEDURE
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4.3 Mutually Authenticating a Client and Server Using 
Their Certificates

The following explains how to mutually authenticate GT OPC UA Client and an OPC UA server using their certificates.

Overview of client certificates and server certificates
A client certificate and a server certificate are digital certificates that are used to mutually authenticate GT OPC UA Client and 
an OPC UA server and to encrypt data.
To connect GT OPC UA Client to an OPC UA server, they need to trust their certificates each other.

1. In the [Access destination device setting] dialog in GT OPC UA Client, click the [Check] button to send a connection 
request to an OPC UA server.

Page 17 [Access destination device setting] dialog

2. The OPC UA server sends its certificate to GT OPC UA Client and requests a client certificate.

3. GT OPC UA Client compares the received server certificate and the certificate stored in advance for verification.

4. GT OPC UA Client sends its certificate to the OPC UA server.

5. The OPC UA server compares the received client certificate and the certificate stored in advance for verification.

6. GT OPC UA Client and the OPC UA server are connected.

Check the authenticity

Trusted server 
certificate

Received 
server certificate

3.

GT OPC UA Client OPC UA server
Connection established

Request for 
connection

1.

6.

Present the server certificate and 
request for presenting the client 
certificate

2.

Present the client 
certificate

4. Check the authenticity

Trusted 
client certificate

Received 
client certificate

5.
Client certificate

Server certificate
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Verifying a server certificate in GT OPC UA Client
You can obtain a server certificate and verify the certificate in the [Access destination device setting] dialog when configuring 
access destination device settings.
Page 17 [Access destination device setting] dialog
If GT OPC UA Client does not have a trusted server certificate, verify a server certificate in the following procedure.

1. In the [Access destination device setting] dialog, click the [Check] button to display the [Authentication of server 
certificate] dialog.

Page 19 [Authentication of server certificate] dialog

2. Click the [OK] button to verify the server certificate.

Verifying a client certificate on an OPC UA server
The authentication method differs depending on the OPC UA server.

Connecting to an OPC UA server that supports automatic verification of client 
certificates
When you send a connection request to a server in the [Access destination device setting] dialog, the client certificate is 
verified.
Page 17 [Access destination device setting] dialog

■When a valid client certificate exists in GT OPC UA Client
Click the [Check] button in the [Access destination device setting] dialog to verify the client certificate on the OPC UA server.

■When a valid client certificate does not exist in GT OPC UA Client
1. Click the [Check] button in the [Access destination device setting] dialog to display the [Creation of client certificate] 

dialog.
Refer to the following, and create a client certificate.
Page 22 [Creation of client certificate] dialog

2. Click the [Check] button again in the [Access destination device setting] dialog to verify the client certificate on the OPC 
UA server.

Connecting to an OPC UA server that does not support automatic verification of client 
certificates
Copy the client certificate to an OPC UA server, and verify the certificate on the server.
The following shows how to verify a client certificate on the OPC UA server.

1. Create a client certificate in GT OPC UA Client.
Page 22 Creating a client certificate

2. Export the client certificate.
Page 23 Exporting a client certificate

3. Copy the client certificate to the OPC UA server, and verify the certificate.
The method of manually verifying a client certificate differs depending on the OPC UA server.
For the details of the verification method, refer to the following.
 OPC UA server manual
4  OPERATING PROCEDURE
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Creating a client certificate
Create a client certificate if a valid client certificate does not exist in GT OPC UA Client.
You do not need to create a client certificate every time GT OPC UA Client connects to an OPC UA server.
The following shows how to create a client certificate.

1. In the main window, select [Client Certificate] → [Create] from the menu to display the [Creation of client certificate] 
dialog.

2. Enter the information of a client certificate.
Setting [Organization name], [Domain], [Strength of RSA key], and [Signature algorithm] is mandatory.
If these fields are not set, a client certificate cannot be created.

3. Click the [OK] button to create a client certificate and security key in the following folders.
Client certificate: C:\Users\(User name)\AppData\Roaming\MELSOFT GT OPC UA Client Setting Tool\PKI\certs
Security key: C:\Users\(User name)\AppData\Roaming\MELSOFT GT OPC UA Client Setting Tool\PKI\private

[Creation of client certificate] dialog

No. Item Description
1) [Organization name] Specify an organization name within 256 characters.

This setting is mandatory.

2) [Unit of organization] Specify an organization unit within 256 characters.

3) [Region name] Specify a region name within 256 characters.

4) [Prefecture/State name] Specify a prefecture or state name within 256 characters.

5) [Country] Specify a country with its ISO 3166-1 alpha-2 code.
Up to two one-byte alphanumeric characters can be entered.
Example) Japan: JP

6) [Domain] Specify a domain within 16 characters.
This setting is mandatory.

7) [Application URI] Displays the application URI. *1

8) [Expiration date] Set the expiration date of the client certificate.
• [1 hour]
• [1 day]
• [1 week]
• [1 month]
• [1 year]
• [2 year]
• [3 year]
• [4 year]
• [5 year]
• [10 year]
• [20 year]

9) [Strength of RSA key] Set the strength of the RSA key.*2

Set this item according to the setting of the OPC UA server to be connected.
This setting is mandatory.
• [1024bits]
• [2048bits]
• [3072bits]
• [4096bits]

1)
2)
3)
4)
5)
6)
7)
8)
9)

10)
12)11)
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*1 The application URI identifies its OPC UA client.
*2 The RSA key is a pair of a public key and a private key used in public-key cryptosystems.

Exporting a client certificate
The following shows how to export a client certificate.

1. In the main window, select [Client Certificate] → [Copy] from the menu to display the [Export Client Certificate] dialog.

2. Specify where to save a client certificate, a file type and a file name, and click the [Save] button to export the certificate to 
a file (*.der).

10) [Signature algorithm] Set a signature algorithm.
Set this item according to the setting of the OPC UA server to be connected.
This setting is mandatory.
• [Sha1]

[Sha256]

11) [OK] button Creates a client certificate and security key, and closes the dialog.

12) [Cancel] button Cancels the settings and closes the dialog.

No. Item Description
4  OPERATING PROCEDURE
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4.4 Obtaining Tag Information and Exporting the 
Information

Obtain tag information from an OPC UA server and export the information to a tag information file (*.gtuc).
If you import the tag information file (*.gtuc) to GT Designer3, you can specify OPC UA tags as devices.
The following shows how to export tag information to a file (*.gtuc).

1. Obtain tag information from an OPC UA server.
Page 24 Obtaining tag information

2. Export the information to a tag information file (*.gtuc).
Page 25 Exporting tag information

Obtaining tag information
The following shows how to obtain tag information with GT OPC UA Client.

1. Connect GT OPC UA Client to an OPC UA server in the [Access destination device setting] dialog.
Page 16 Connecting GT OPC UA Client to an OPC UA Server

2. In the main window, select [Tag] → [Import Tags] from the menu to obtain tag information from the OPC UA server.

Main window

No. Item Description
1) Server name Displays the OPC UA server name.

2) Tag information tree Displays the tag information obtained from the OPC UA server in the tree structure.
Select a folder to list the OPC UA tags in the folder in the tag list.

3) Tag list Displays the OPC UA tags in a list.

4) [Tag Name] Displays the OPC UA tag names.

1)

2)

8)

4) 5) 6) 7)

3)
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Exporting tag information
The following shows how to export tag information.

1. In the main window, select [Tag] → [Export Tags] from the menu to display the [Export Tags] dialog.

2. Specify where to save tag information, a file type and a file name, and click the [Save] button to save the tag information 
to a tag information file (*.gtuc).

5) [Data Type] Displays the data types of the OPC UA tags.
• [Boolean]: Bit
• [SByte]: Signed 8-bit integer
• [Byte]: Unsigned 8-bit integer
• [Int16]: Signed 16-bit integer
• [UInt16]: Unsigned 16-bit integer
• [Int32]: Signed 32-bit integer
• [UInt32]: Unsigned 32-bit integer
• [Int64]: Signed 64-bit integer
• [UInt64]: Unsigned 64-bit integer
• [Float]: Single-precision real number
• [Double]: Double-precision real number
• [String]: Character string
• [---]: Data type that is not supported by GT Designer3

Some OPC UA tags listed cannot be used in GT Designer3.
For the OPC UA tags usable in GT Designer3, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

6) [Access Direction] Displays the access permissions of the OPC UA tags.
• [Read]: Reading permitted only
• [Write]: Writing permitted only
• [Read, Write]: Reading and writing permitted

7) [Comment] Displays the comments for the OPC UA tags.

8) Status bar Displays the current status.

No. Item Description
4  OPERATING PROCEDURE
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5 STARTING GT OPC UA Client FROM GT 
Designer3

If GT Designer3 and GT OPC UA Client are installed on the same personal computer, you can start GT OPC UA Client from 
GT Designer3 to import tag information.
In such a case, export tag information to a file (*.gtuc) with GT OPC UA Client, and import the file to GT Designer3 in the 
following procedure.

1. Obtain the name of the target OPC UA server in the [Access destination device setting] dialog.
Page 16 Connecting GT OPC UA Client to an OPC UA Server

2. Establish a trust relation between GT OPC UA Client and the OPC UA server using their certificates as necessary.
Page 21 Verifying a server certificate in GT OPC UA Client
Page 21 Verifying a client certificate on an OPC UA server

3. In the main window, obtain tag information from the OPC UA server.
Page 24 Obtaining tag information

4. Export the information to a tag information file (*.gtuc).
Page 25 Exporting tag information

5. When the export is complete, the following dialog appears.
Click the [OK] button to send the path to the tag information file to GT Designer3 and exit GT OPC UA Client.

6. Import the tag information file to GT Designer3.
For details on how to import the file, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual
5  STARTING GT OPC UA Client FROM GT Designer3
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6 EXPORTING A CLIENT CERTIFICATE FOR GT 
SoftGOT2000

A client certificate is required to connect GT SoftGOT2000 with an OPC UA server.
A client certificate created by GT OPC UA Client is usable for GT SoftGOT2000 to connect to an OPC UA server.
The following shows how to export a client certificate for GT SoftGOT2000.

1. In the main window, select [Client Certificate] → [Export for GT SoftGOT] from the menu to display the [Export Client 
Certificate for GT SoftGOT2000] dialog.

2. Specify where to save a client certificate, a file type, and a file name, and click the [Save] button to export the certificate 
for GT SoftGOT2000 to a file (*.gtcl).

3. Import the client certificate (*.gtcl) in the [Communication Setup] dialog of GT SoftGOT2000.
For the details of the [Communication Setup] dialog in GT SoftGOT2000, refer to the following.
GT SoftGOT2000 Version1 Operating Manual
6  EXPORTING A CLIENT CERTIFICATE FOR GT SoftGOT2000
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7 CHANGING THE DISPLAY LANGUAGE
You can change the display language of GT OPC UA Client.
Japanese, English, and Simplified Chinese are supported.

1. In the main window, select [View] → [Switch Display Language] from the menu to display the [Switch Display Language] 
dialog.

2. Select a language and click the [OK] button to change the display language.

7.1 [Display Language] Dialog

No. Item Description
1) [Display Language] Select a display language.

2) [OK] button Changes the display language and closes the dialog.

3) [Cancel] button Cancels the settings and closes the dialog.

1)

2)
3)
7  CHANGING THE DISPLAY LANGUAGE
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8 PRECAUTIONS

Updating the tag information
GT OPC UA Client does not collect tag information periodically.
If tag information is updated, added, or deleted on an OPC UA server, obtain the tag information with GT OPC UA Client again 
and update the tag information of GT Designer3.

Precautions for drawing
For the precautions for using OPC UA tags in GT Designer3, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual
8  PRECAUTIONS
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9 TROUBLESHOOTING

9.1 Troubleshooting
If GT OPC UA Client does not operate properly, check the following and troubleshoot problems.

Troubleshooting problems with data collection

GT OPC UA Client cannot connect to an OPC UA server.

Troubleshooting problems with screen display

On-screen items appear improperly.

*1 Check the version of Windows in the following procedure.
(1) Hold down the Windows key and press the [R] key, or select [Windows System] → [Run] from the Windows start menu.
(2) Enter "winver" on the [Run] screen.
(3) Check the version on the displayed screen.

*2 Some on-screen items may appear blurry due to rescaling.
The following shows the settable values for [Change the size of text, apps, and other items] in Windows 10 and the recommended 
display resolution for each value.
Value: 100%, display resolution: 1024 × 768 dots or higher
Value: 125%, display resolution: 1900 × 1200 dots or higher
Value: 150%, display resolution: 1900 × 1200 dots or higher
Value: 175%, display resolution: 2880 × 1620 dots or higher
Value: 200%, display resolution: 2880 × 1620 dots or higher
Value: 225%, display resolution: 3840 × 2160 dots or higher
Value: 250%, display resolution: 3840 × 2160 dots or higher

*3 GtOpcUaClientTool.exe is stored in the folder where GT OPC UA Client Setting Tool is installed.
The following shows an example of the location of the file.
Example) When the install destination folder is set as default
C:\Program Files\MELSOFT\GTOPCUAClient

Check if: Corrective action
The client certificate is trusted by the OPC UA server. Trust the client certificate on the OPC UA server.

For the details, refer to the following.
Page 21 Verifying a client certificate on an OPC UA server

A same-name client certificate is stored. Delete the expired client certificate, and create a client certificate.
The client certificate is stored under the following folder path:
C:\Users\(User name)\AppData\Roaming\MELSOFT GT OPC UA Client Setting 
Tool\PKI\certs
File name: GTOPCUA.der
For the details, refer to the following.
Page 22 Creating a client certificate

The client certificate has expired.

The host name for the endpoint URL is the same as the host name 
set on the server.

Check the host name in the server certificate.
The server certificate is stored under the following folder path:
C:\Users\(User name)\AppData\Roaming\MELSOFT GT OPC UA Client Setting 
Tool\PKI\trusted

The OPC UA server is on the host or subnet on which GT OPC UA 
Client resides.

Check the system configuration.

The firewall settings are configured correctly. Check the firewall settings on your personal computer.

Check if: Corrective action
[Change the size of text, apps, and other items] is set to 100% in 
Windows.

• Set [Change the size of text, apps, and other items] to 100%.
• In Windows 10 (version 1703 or later), the on-screen items can be rescaled to the 

specified percentage of normal size. *1*2

(1) Select GtOpcUaClientTool.exe, and then select [Properties] from the right-click context 
menu. *3

(2) On the [Compatibility] tab, select [Override high DPI scaling behavior. Scaling 
performed by:], and select [System] from the pull-down menu. 
(3) Click the [OK] button.
9  TROUBLESHOOTING
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9.2 Error Messages
The following shows the error messages that may appear when GT OPC UA Client is used.

Error message Cause Corrective action
Failed to acquire a server certificate.
The security policy and the security mode 
may not be matched with those of the server.

The security policy and security mode do not 
match with those of the server.

Set the security policy and security mode of the OPC UA 
server.
Multiple security policies and security modes can be set 
depending on the OPC UA server. Check the specifications of 
the server.
Page 17 [Access destination device setting] dialog

Access is denied from the server.
Please check user name and password.
If it is an anonymous user, please make sure 
that it is set to be accessible by anonymous 
user on the server side.

• The user name or password is not correct.
• An anonymous user is selected to access 

the server that does not allow access from 
anonymous users.

Check the user name and password.
Page 17 [Access destination device setting] dialog

Access is denied from the server.
The client certificate may not be trusted by 
the server.

The client certificate is not trusted by the 
server.

Trust the client certificate on the OPC UA server.

Failed to connect to the server.
Please check the following settings.
• Host Name of End point URL
• Server settings
• Communication environment

The connection to the server has failed. • Check the settings of the OPC UA server.
• Check the following troubleshooting.
Page 34 GT OPC UA Client cannot connect to an OPC 
UA server.
• Uninstall GT OPC UA Client, and install it again.
• If the error recurs, contact your local sales office.

The server has reached its maximum number 
of sessions.
Please check the number of sessions 
connected to the server.

The number of sessions on the server 
exceeds the maximum value.

Check the number of concurrent sessions on the server.

Failed to connect to the server.
Please wait a while and try access again.

The server is busy. Wait a while and try again.

[Save destination path]
The client certificate cannot be created in this 
folder.
Please check an access permission.

You do not have permission to access the 
folder where the client certificate is stored.

Contact the administrator and obtain the access permission.

[Save destination path]
The server certificate cannot be saved in this 
folder.
Please check an access permission.

You do not have permission to access the 
folder where the server certificate is stored.

Contact the administrator and obtain the access permission.

[File name] cannot be saved in the specified 
path.
Possible causes are shown below.
• The folder path does not exist.
• The route drive is specified.
• The destination is read only.
• Other user is editing the destination.
• Memory required for save is insufficient.
• Medium of the specified drive is broken.
• The specified file name is too long.
• Other errors occurred during the saving 

process.
Save the project in another drive once.

The access destination device setting cannot 
be saved due to disconnection of the network 
or other causes.

Take the following actions according to the cause.
• Check the network environment.
• Check the path to the save destination.
• Specify a folder as the save destination.
• Check that any data in the save destination is not being 

edited.
• Free up disk space to store the file.
• Check that the physical drive where the file will be saved is 

not broken.
• Change the file name.

Failed to retrieve the file.
Possible causes are shown below.
• Free space of the media where the access 

destination device setting being saved is 
insufficient.

• File data is broken.
• The access destination device setting file 

does not exist in the specified path.

• The medium where the setting file (*.gtpm) 
is saved has insufficient free space.

• The setting file (*.gtpm) is corrupt.
• The specified path to the setting file 

(*.gtpm) is incorrect.

• Free up space on the medium where the access destination 
device setting file is saved.

• Create a setting file (*.gtpm) again.
Page 19 Saving access destination device settings to a 
file
• Specify the path where the file to be read is stored.

There is a possibility that the environment of 
the application is broken.
Please install it again.

The registry is in one of the following states.
• The registry is nonexistent.
• The registry is in a state in which it cannot 

be read.
• An invalid value is set in the registry.

Uninstall GT OPC UA Client, and install it again.
Page 12 INSTALLATION AND UNINSTALLATION
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Failed to start tool with the display language 
specified at the time of previous termination.
Tool will be started with the default language.

• GT OPC UA Client has failed to start with 
the language specified at the time of the 
previous termination.

• GT OPC UA Client has failed to read a file 
when displaying the [Switch Display 
Language] dialog.

• Configure the settings in the [Switch Display Language] 
dialog again.

• Uninstall GT OPC UA Client, and install it again.

The help file cannot be found.
Please install GT OPC UA Client.

The help file (PDF) does not exist. Install GT OPC UA Client again, and try to view the help.
Page 12 INSTALLATION AND UNINSTALLATION

Failed to load client certificate.
Please create the client certificate again.

Reading a client certificate has failed. Create a client certificate again.
Page 22 Creating a client certificate

Access is denied from the server.
The client certificate is expired.
Please create the client certificate again.

The client certificate has expired. Create a client certificate again.
Page 22 Creating a client certificate

Failed to get tag information.
Please check the server setting.

The obtained tag information (NodeID, 
DisplayName, DataType, or AccessLevel) is 
invalid.

Check the settings of the OPC UA server.

Failed to export tag information.
Please export it again.

Exporting tag information has failed. Export tag information again.
Page 24 Obtaining Tag Information and Exporting the 
Information

Failed to acquire a server certificate.
Please install the certificate on the server.

• A server certificate is not installed on the 
connected server.

• The server certificate has expired.

Install a valid server certificate on the connected server.
Verify the server certificate in GT OPC UA Client afterward.
Page 21 Verifying a server certificate in GT OPC UA 
Client

An unexpected error occurred. An unexpected error has occurred. • Check the settings of the OPC UA server.
• Check the following troubleshooting.
Page 34 GT OPC UA Client cannot connect to an OPC 
UA server.
• Uninstall GT OPC UA Client, and install it again.
• If the error recurs, contact your local sales office.

Error message Cause Corrective action
9  TROUBLESHOOTING
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10 APPENDICES

10.1 Open Source Software
This software consists of multiple software components. Each copyright of the software component belongs to Mitsubishi 
Electric or third parties.
This software includes the following open source software.
 • Software with copyright of third party and distributed as a free software
For the software with copyrights that belong to Mitsubishi Electric or third parties, the source code is not distributed.
Please refrain from asking information on the source code of open source.

Software information
The open source software included in this product is as follows.
 • RapidJSON
Page 37 RapidJSON
 • BouncyCastle
Page 38 BouncyCastle
 • OpenSSL toolkit
Page 38 OpenSSL toolkit

RapidJSON
RapidJSON, which is the MIT license, is used in this product.
The following describes the copyright notice and agreement notice of RapidJSON.
Tencent is pleased to support the open source community by making RapidJSON available.

Copyright (C) 2015 THL A29 Limited, a Tencent company, and Milo Yip. All rights reserved.
If you have downloaded a copy of the RapidJSON binary from Tencent, please note that the RapidJSON binary is licensed under the MIT License.
If you have downloaded a copy of the RapidJSON source code from Tencent, please note that RapidJSON source code is licensed under the MIT License, 
except for the third-party components listed below which are subject to different license terms. Your integration of RapidJSON into your own projects may 
require compliance with the MIT License, as well as the other licenses applicable to the third-party components included within RapidJSON. To avoid the 
problematic JSON license in your own projects, it's sufficient to exclude the bin/jsonchecker/ directory, as it's the only code under the JSON license.
A copy of the MIT License is included in this file.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the 
Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, 
and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR 
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR 
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
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BouncyCastle
BouncyCastle, which is the MIT license, is used in this product.
The following describes the copyright notice and agreement notice of BouncyCastle.

OpenSSL toolkit
OpenSSL toolkit, which is OpenSSL License and Original SSLeay License, is used in this product.
The following describes the agreement notice of OpenSSL License and Original SSLeay License.

Copyright (c) 2000 - 2017 The Legion of the Bouncy Castle Inc. (http://www.bouncycastle.org)

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the 
Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, 
and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR 
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR 
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

LICENSE ISSUES
==============

The OpenSSL toolkit stays under a double license, i.e. both the conditions of
the OpenSSL License and the original SSLeay license apply to the toolkit.
See below for the actual license texts.

OpenSSL License
---------------

/* ====================================================================
* Copyright (c) 1998-2018 The OpenSSL Project. All rights reserved.
*
* Redistribution and use in source and binary forms, with or without
* modification, are permitted provided that the following conditions
* are met:
*
* 1. Redistributions of source code must retain the above copyright
* notice, this list of conditions and the following disclaimer.
*
* 2. Redistributions in binary form must reproduce the above copyright
* notice, this list of conditions and the following disclaimer in
* the documentation and/or other materials provided with the
* distribution.
*
* 3. All advertising materials mentioning features or use of this
* software must display the following acknowledgment:
* "This product includes software developed by the OpenSSL Project
* for use in the OpenSSL Toolkit. (http://www.openssl.org/)"
*
* 4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
* endorse or promote products derived from this software without
* prior written permission. For written permission, please contact
* openssl-core@openssl.org.
*
* 5. Products derived from this software may not be called "OpenSSL"
* nor may "OpenSSL" appear in their names without prior written
* permission of the OpenSSL Project.
*
* 6. Redistributions of any form whatsoever must retain the following
* acknowledgment:
* "This product includes software developed by the OpenSSL Project
10  APPENDICES
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* for use in the OpenSSL Toolkit (http://www.openssl.org/)"
*
* THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY
* EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
* PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR
* ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
* SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
* NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
* LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
* STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
* ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
* OF THE POSSIBILITY OF SUCH DAMAGE.
* ====================================================================
*
* This product includes cryptographic software written by Eric Young
* (eay@cryptsoft.com). This product includes software written by Tim
* Hudson (tjh@cryptsoft.com).
*
*/

Original SSLeay License
-----------------------

/* Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
* All rights reserved.
*
* This package is an SSL implementation written
* by Eric Young (eay@cryptsoft.com).
* The implementation was written so as to conform with Netscapes SSL.
*
* This library is free for commercial and non-commercial use as long as
* the following conditions are aheared to. The following conditions
* apply to all code found in this distribution, be it the RC4, RSA,
* lhash, DES, etc., code; not just the SSL code. The SSL documentation
* included with this distribution is covered by the same copyright terms
* except that the holder is Tim Hudson (tjh@cryptsoft.com).
*
* Copyright remains Eric Young's, and as such any Copyright notices in
* the code are not to be removed.
* If this package is used in a product, Eric Young should be given attribution
* as the author of the parts of the library used.
* This can be in the form of a textual message at program startup or
* in documentation (online or textual) provided with the package.
*
* Redistribution and use in source and binary forms, with or without
* modification, are permitted provided that the following conditions
* are met:
* 1. Redistributions of source code must retain the copyright
* notice, this list of conditions and the following disclaimer.
* 2. Redistributions in binary form must reproduce the above copyright
* notice, this list of conditions and the following disclaimer in the
* documentation and/or other materials provided with the distribution.
* 3. All advertising materials mentioning features or use of this software
* must display the following acknowledgement:
* "This product includes cryptographic software written by
* Eric Young (eay@cryptsoft.com)"
* The word 'cryptographic' can be left out if the rouines from the library
* being used are not cryptographic related :-).
* 4. If you include any Windows specific code (or a derivative thereof) from
* the apps directory (application code) you must include an acknowledgement:
* "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"
10  APPENDICES
10.1  Open Source Software 39



40
*
* THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND
* ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
* ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
* FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
* DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
* OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
* LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
* OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
* SUCH DAMAGE.
*
* The licence and distribution terms for any publically available version or
* derivative of this code cannot be changed. i.e. this code cannot simply be
* copied and put under another distribution licence
* [including the GNU Public Licence.]
*/
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REVISIONS
* The manual number is given on the bottom left of the back cover.

©2019 MITSUBISHI ELECTRIC CORPORATION

Print date * Manual No. Revisions
April 2019 SH(NA)-082174ENG-A First edition

October 2019 SH(NA)-082174ENG-B Partial corrections

April 2022 SH(NA)-082174ENG-C Compatible with Windows 11

April 2023 SH(NA)-082174ENG-D Ended: Support for Windows 8.1, Windows 8, and Windows 7

This manual confers no industrial property rights or any rights of any other kind, nor does it confer any patent licenses. Mitsubishi Electric Corporation cannot 
be held responsible for any problems involving industrial property rights which may occur as a result of using the contents noted in this manual.
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Intellectual Property Rights
Trademarks
MELDAS, MELSEC, iQ Platform, MELSOFT, GOT, CC-Link, CC-Link/LT, and CC-Link IE are trademarks or registered 
trademarks of Mitsubishi Electric Corporation in Japan and other countries.
Microsoft, Windows, Windows Vista, Windows NT, Windows Server, SQL Server, Visual C++, Visual C#, Visual Basic, Excel, 
and Access are trademarks or registered trademarks of Microsoft Corporation in the United States and other countries.
Adobe and Adobe Reader are registered trademarks of Adobe Systems Incorporated.
Intel and Intel Core are trademarks or registered trademarks of Intel Corporation in the United States and other countries.
Other company and product names herein are trademarks or registered trademarks of their respective owners.
Copyrights
"OPC UA Services for WPF" is used in this product.
.NET based OPC UA Client SDK(binary)
(c)2006-2019 Unified Automation GmbH. All rights reserved
The screens (screenshots) are used in accordance with the Microsoft Corporation guideline.
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